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Release Notes for Nuke 9.0v3



Release Date 18 December 2014



Qualified Operating Systems • Mac OS X 10.7 (Lion), 10.8 (Mountain Lion), 10.9 (Mavericks) NOTE: Nuke is expected to function correctly under Mac OS X 10.9 (Mavericks), but we are seeing UI performance degradation compared to previous OS X versions. We are working on resolving these issues. • Windows 7 64-bit and Windows 8 64-bit • CentOS/RHEL 5 and CentOS/RHEL 6 Other operating systems may work with Nuke, but have not been fully tested. If you have any problems with a particular operating system, please contact [email protected].



Hardware Requirements for Real-time Playback The following is a list of recommended hardware configurations that The Foundry have certified for 4K real-time playback (see the note below). Please note that 4K playback may also work on other machine configurations, but the ones listed below are ones which have been tested. NOTE: The 4K playback requirements listed here refer to streaming playback for 10-bit DPX rgb files at 30 fps, 4K UHD, with audio and a monitor output device enabled. Other file formats may also play back at 4K and above, given sufficient disk read speeds.



Mac Certified Box Hardware • Mac Pro, Late 2013
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• Software OS X 10.9.5 (13F34) • 3.5 GHz 6-Core Intel Xeon E5 • GPU - FirePro D500 3072 MB • 32 GB 1867 MHz DDR3 ECC



Monitor Output • BlackMagic: UltraStudio 4K (Thunderbolt 2) • Desktop Video Software Driver 10.3 • Thunderbolt 2 • Download Link: https://www.blackmagicdesign.com/support/download/35045/Mac%20OS%20X OR • AJA: IO4K (Thunderbolt 2) • Mac Driver v10.6 (Firmware version 'IO4K (4K mode)' • Download Link: http://www.aja.com/assets/support/files/2697/en/AJA_Io4K_10_6.zip WARNING: T-Tap is not currently supported.



Windows Certified Box Hardware • Windows 7 • 2 x 3.4 GHz, 8-Core • NVIDIA Quadro K5200, NVIDIA Driver 340.x • 32 GB RAM



Monitor Output • BlackMagic: Decklink 4K Extreme OR Decklink 4K Studio, • Desktop Video Driver 10.3 • Download Link: https://www.blackmagicdesign.com/support/download/35045/Windows OR • AJA: Kona 3G OR Kona 4 • AJA Hardware Driver v10.5.2 - Windows (64-bit) • Download Link: http://www.aja.com/assets/support/files/2620/en/AJA_Win_Drivers-10.5.2-x64.msi.zip



Linux Certified Box Hardware • CentOS/RHEL 6.5, • 2 x 3.4 GHz, 8-Core • NVIDIA Quadro K5200, NVIDIA Driver 340.x
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• 32 GB RAM



Monitor Output • BlackMagic Decklink 4K Extreme, Decklink 4K Studio • Desktop Video Driver 10.3 • Download Link: https://www.blackmagicdesign.com/support/download/35045/Linux



Disk Storage and Read/Speeds • Windows/Linux: HP Z Turbo Drive OR Fusion ioFX, PCIe cards • Mac OS X: LaCie Little Big Disk 1TB, Thunderbolt 2 • Network attached storage: Minimum of sustained 1GB/s read speed NOTE: See the Nuke User Guide Installation and Licensing section or the online help here, regarding example formats and data rates.



Requirements for GPU Acceleration If you want to enable Nuke to calculate certain nodes using the GPU, there are some additional requirements. You need to have: • an NVIDIA GPU with compute capability 2.0 (Fermi) or above. A list of the compute capabilities of NVIDIA GPUs is available at www.nvidia.co.uk/object/cuda_gpus_uk.html NOTE: The compute capability is a property of the GPU hardware and can't be altered by a software update. With graphics drivers capable of running CUDA 4.2 or above. NOTE: In order to use R3D GPU debayering in the Compositing environment, CUDA 6.0 (or higher) is required. See Release Notes for Nuke 9.0v3 for more information. • On Windows and Linux, CUDA graphics drivers are bundled with the regular drivers for your NVIDIA GPU. Drivers from April 2012 onward support CUDA 4.2. Go to http://www.nvidia.com/Download/Find.aspx?lang=en-us for more information. • On Mac, the CUDA driver is separate from the NVIDIA graphics driver and must be installed, if you don't have it already. The minimum requirement for CUDA 4.2 is driver version 4.2.5, which can be downloaded from www.nvidia.com/drivers. NOTE: We recommend using the latest graphics drivers, where possible, regardless of operating system.
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• an AMD FirePro GPU on late 2013 Mac Pro 6,1, running OS X 10.9.3 'Mavericks', or later (see below and the Blink API documentation for caveats on CPU/GPU result consistency on Mac Pros).



Late 2013 Mac Pro Only Nuke Studio supports GPU-enabled nodes on the late 2013 Mac Pro 6,1 (running OS X 10.9.3 'Mavericks', or later), including a new Enable multi-GPU support option. When enabled in the preferences, GPU processing is shared between the available GPUs for extra processing speed. NOTE: Due to outstanding Mac OS X issues with OpenCL, GPU processing is not currently available on late 2013 Mac Pro 6.1, in the following circumstances: • If you're running an earlier version of Mac OS X than 10.9.4 'Mavericks', Kronos and MotionBlur do not support GPU acceleration. • If you're running an earlier version of Mac OS X than 10.9.5 'Mavericks' and processing images greater than 4 mega pixels resolution, VectorGenerator, Kronos, and MotionBlur do not support GPU acceleration.



Launching and Licensing Information • Nuke can be run on the command line from the installation directory without any arguments. For example, on Windows: C:\Program Files\Nuke9.0v2\Nuke9.0.exe NukeX and Nuke Studio can be run on the command line from the installation directory using the --nukex and         --studio arguments. For example, on Windows: C:\Program Files\Nuke9.0v2\Nuke9.0.exe --studio • NukeX requires nukex_i and nuke_i licenses with valid maintenance. • Nuke Studio requires nukestudio_i, nukex_i, and nuke_i licenses with valid maintenance.



New Features There are no new features for this release.



Feature Enhancements There are no feature enhancements in this release.
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Bug Fixes • BUG ID 46981 - Flipbooking a sequence that didn't start at frame 0 offset the output by a number frames equal to the first rendered frame and displayed a cannot load image file . No such file or directory error.



Known Issues and Workarounds This section covers known issues and gives workarounds for them, where appropriate.



Known Issues Specific to Nuke 9.0 GPU • BUG ID 45018 - R3D: Only half float linear gamma space works with GPU debayering.



Installation and Licensing • Mac OS X only: If you're running Mac OS X 10.10 "Yosemite", you may need to install alternative NVIDIA CUDA drivers so that Nuke can detect your GPU correctly. You can obtain the required drivers directly from NVIDIA here: http://www.nvidia.com/object/macosx-cuda-6.5.18-driver.html • BUG ID 41981 - Licensing: Launching Nuke on new MacPros with multiple Thunderbolt devices may display a licensing dialog explaining that FLEXlm licensing has been disabled, probably due to having too many ethernet addresses active on the machine. Please contact [email protected] to work around this issue.



Keyboard Shortcuts • BUG ID 42581 - Linux only: Using Ctrl+C to quit Nuke from the command line when a dialog box is open displays an error.



Read and Write • BUG ID 46691- ProRes4444 movies read in with the 64-bit movReader are not currently displaying the correct alpha channel. • BUG ID 42717 - Certain .exr files rendered from Modo display the alpha channel rather than the rgba channels by default. • BUG ID 31424 - Sub-sampling in .exr files is not currently supported.
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Miscellaneous • BUG ID 46488 - Switching between certain workspaces displays black in the Viewer until the frame is changed. • BUG ID 46441 - ParticleBounce: Using custom geometry as the bounce object in a particle system occasionally allows particles to pass through the bouce surface. • BUG ID 42159 - Nodes that use the Iop::sample() call to get input pixels, such as LensDistortion, perform poorly when they are downstream of nodes using PlanarIop, such as Denoise.



Known Issues Specific to Nuke Studio 9.0 Create Comp • Multi-view, such as stereoscopic, is not supported for track items created using right-click Effects > Create Comp. • BUG ID 46863 - Rendering Nuke comps on the timeline in projects that have remapping, results in the comp container failing to show renders. • BUG ID 46470 - Create Comp: Enabling Collate Shot Name in the comp export preset offsets the comp frame range compared to the annotations precomp frame range. • BUG ID 41665 - There are currently no options to load or overwrite an existing script when you select Create Comp.



Keyboard Shortcuts • BUG ID 34779 - Mac OS X only: The shortcut for Clear In/Out Points (Alt+U) is not always triggered correctly due to a conflict with the combination for the umlaut symbol. To work around this, press U momentarily before Alt+U.



Preferences • The Preferences > Path substitution table for cross platform compatibility currently only comes into effect at project load, not EDL/XML import. As a workaround, import your sequence and set the Path substitution rule, then save the project and reload to force the conversion.



Python API • BUG ID 44394 - Calling hiero.core.addPathRemap() does not work for soft effect file paths.



Read and Write • Linux only: Nuke Studio does not currently support any QuickTime audio reading. Support for audio on Linux is scheduled for a later release.
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RELEASE NOTES FOR NUKE 9.0V3 | KNOWN ISSUES AND WORKAROUNDS



• BUG ID 46100 - Exporting: Export speeds may be slower than expected. This may be due to the Rendering preference set to limit renderer. As a work around, you can change the preference Performance > Threads/Processes > Rendering > export renders to no renderer limits to improve rendering speeds. You can also experiment with the custom renderer limits, to adjust performance on your machine. • BUG ID 39897 - Importing and playing back very large format .tif files causes Nuke Studio to crash. • BUG ID 39557 - Writing .exrs with 200+ layers, when interleave is set to channels, can be sluggish. • BUG ID 39113 - Mac OS X only: QuickTime ProApps Codecs v1.0.3 break HDV and XDCAM on Mac OS X 10.7.5, and earlier. This is a codec issue rather than an application issue. • BUG ID 35080 - QuickTime: Certain files read into Nuke Studio with a different start timecode to other applications, such as Premiere or Resolve. • BUG ID 31549 - Single layer exports from multi-pass clips fail if the selected layer is not a default Nuke layer, such as depth or motion. • BUG ID 28701 - Windows only: Nuke Studio cannot currently parse Unicode characters during export. • BUG ID 28067 - Certain formats produce no monitor output, such as 2K 23.98 and 720P 25. • BUG ID 18880 - R3D: The aspect ratio of anamorphic .r3d footage is not displayed correctly when added to the timeline.



Soft Effects • BUG ID 42438 - Effects are only visible in the Viewer if there is a track item below them in the timeline. • BUG ID 42401 - Renaming a soft effect does not update the track item until you click in the timeline. • BUG ID 42307 - Adding soft effects at clip level, using Open In > Timeline View, is only available using the add effect button on the timeline panel. The right-click Effects menu is currently disabled.



Viewers • BUG ID 46156 - Timeline Viewer: The crop to format control has been removed from the Viewer controls dropdown, but remains in the Preferences > Panels > Viewer (Sequence) tab. We recommend that you do not enable this control as it does not function as expected. • BUG ID 42053 - It is currently possible to change the displayed frame range in the Compositing Viewer by dragging the playhead past the current frame range in Input and Global modes.



Miscellaneous • BUG ID 46235 - Comps with relative paths are not currently working when imported into the Project bin. • BUG ID 43913 - Locking a track currently prevents adding track items from the locked track to the Viewer input buffers. You can still open track items in the various right-click Open In options and access track item metadata. • BUG ID 42462 - Cache pausing stops working if any change is made to the timeline. • BUG ID 41745 - It is not currently possible to drag-and-drop a clip to a new track between or below existing tracks. As a workaround, drag the clip to a new top-level track and then manually move the track to the required position.
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RELEASE NOTES FOR NUKE 9.0V3 | KNOWN ISSUES AND WORKAROUNDS



• BUG ID 32613 - Linux only: Dragging clips to the timeline with certain older NVIDIA drivers occasionally causes Nuke Studio to crash. As a workaround, ensure that you have the latest NVIDIA drivers installed, available from: www.nvidia.com/Download/index.aspx?lang=en-us • BUG ID 27484 - It is not currently possible to alter the Output Resolution of clips opened using the right-click Open in Timeline option.



Other Known Issues AudioRead • BUG ID 18924 - Changes to the rate control value are not honored when ratesource is toggled between file and custom. • BUG ID 18666 - Changing the sample rate has no effect on playback in a Flipbook. • BUG ID 18465 - The time range control doesn’t limit the range when an endtime is specified. • BUG ID 18451 - Flipbooking doesn't honor the time range knob. • BUG ID 18217 - Redo keyframe generation doesn't replace the keys. • BUG ID 18213 - Changing Draw Style in the Curve Editor or Dope Sheet doesn't redraw the curves correctly.



BlinkScript/CUDA • BUG ID 44138 - BlinkScript: float3x3 and float4x4 matrix constructors currently produce a GPU compliation error. As a workaround, you can pass the following in as a kernel parameter: float matrixData[] = {1,1,1,1,1,1,1,1,1,1,1,1,1,1,1,1}; float4x4 matrix; m.setArray(matrixData); • BUG ID 43319 - CUDA: Scripts containing GPU accelerated nodes, such as ZDefocus, display a CUDA error when the OS wakes up from sleep mode.



CameraTracker • BUG ID 40798 - Centering a track in the Viewer does not work as expected in proxy or downrez modes. • BUG ID 40092 - Stereo: Tracking progress hangs at 100% when Source is set to Stills in stereo scripts. • BUG ID 37411 - Sequences containing alpha channels display the alpha premultiplied by the image in reference thumbnails, rather than just the RGB values.



Deep • BUG ID 43383 - Executing a script in terminal mode that reads in a deep image and then writes it to disk, causes Nuke to crash. As a workaround, run the script from the Script Editor inside Nuke.
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RELEASE NOTES FOR NUKE 9.0V3 | KNOWN ISSUES AND WORKAROUNDS



• BUG ID 40145 - Nuke occasionally reads and writes Deep .exr files with a pixel aspect ratio of 1. As a workaround, preview the .exr in the file browser before reading it into Nuke.



Dope Sheet • BUG ID 43463 - Scripts containing Ocula's O_VerticalAligner plug-in cause Nuke to crash when you execute Analyze Sequence with the Dope Sheet open. • BUG ID 40206 - Adding a curve to the Dope Sheet and then deleting it causes Nuke to crash. • BUG ID 39426 - Undoing individually animated text characters removes their keys completely from the Dope Sheet. • BUG ID 39338 - Clicking the Move button for a selection and then undoing the move does not work as expected. • BUG ID 39156 - Keys remapped with descending TimeWarp lookup curves don't snap to frames when frame snap is enabled. • BUG ID 38910 - Keys from Viewer buffers not currently being viewed are still visible. • BUG ID 38630 - Read and TimeClip representations disappear in the Dope Sheet if they are set to have a nonempty frame expression. • BUG ID 37869 - The Dope Sheet is not updated correctly when a Retime's speed control is animated. • BUG ID 37815 - Multiple instances of the same clip within one AppendClip are only represented once in the Dope Sheet.



EditGeo • BUG ID 38954 - The transform handle of selections in the Viewer is not updated between frames on geometry with animation baked into its vertices. To update the transform handle, toggle the axis alignment control between object and average normal. • BUG ID 38699 - Changing the visibility of objects within an Alembic Scene Graph causes geometry to ignore the EditGeo node. • BUG ID 38670 - Setting a keyframe can be slow to update the Viewer with the appropriate keyframe marker. • BUG ID 36094 - Setting axis alignment to average normal displays the axis incorrectly on edge and corner vertices.



Import Nuke • BUG ID 40131 - Importing Nuke in a Python script destroys sys.argv, making command line arguments unavailable. As a workaround, preserve sys.argv in another variable before you import Nuke. • BUG ID 39836 - Importing Nuke hangs when there are Qt conflicts between Nuke and other applications. • BUG ID 38963 - Calling import nuke terminates the Python session if no applicable license is available.



Linux only • BUG ID 43766 - Calling uuid.uuid4() causes Nuke to crash due to a bug in libc.



9



RELEASE NOTES FOR NUKE 9.0V3 | KNOWN ISSUES AND WORKAROUNDS



As a workaround, launch Nuke from the command line using: LD_PRELOAD=/lib64/libuuid.so.1 ./Nuke8.0 • BUG ID 39537 - Using a Blackmagic Decklink Extreme 2 card causes Nuke to become unresponsive.



Mac OS X only • BUG ID 45241 - Mac OS X 10.10 (Yosemite) only: Dragging and dropping media into the Node Graph does not work as expected. • BUG ID 43607 - Mac OS X 10.10 (Yosemite) only: Double-clicking the NukeX dock icon launches standard Nuke. • BUG ID 43343 - Modifying the label of a Python user knob causes Nuke to crash. • BUG ID 41981 - Licensing: Launching Nuke on new MacPros with multiple Thunderbolt devices may display a licensing dialog explaining that FLEXlm licensing has been disabled, probably due to having too many ethernet addresses active on the machine. Please contact [email protected] to work around this issue. • BUG ID 39429 - Crash Reporting: The 'save to' dialog is hidden behind the crash report dialog when you click Save Report. • BUG ID 38686 - Enabling Use GPU if available on supported nodes, such as Kronos, in more than one instance of Nuke at the same time, can cause display corruption and/or entire system freezes. This seems particularly likely to occur on GPUs with low amounts of RAM, such as the GeForce GT 650M. As a workaround, upgrade your NVIDIA drivers, or if this is not possible, only enable GPU acceleration in one instance of Nuke at a time. • BUG ID 35123 - PrmanRender: If you're using Mac OS X 10.8 (Mountain Lion) or above, make sure X11 is installed on your system. Unlike previous versions of OS X, 10.8 and above do not have X11 installed by default. For more information, see http://support.apple.com/kb/HT5293. • BUG ID 34697 - Launching Nuke from a network shared drive causes Nuke to crash on launch. As a workaround, either: • tarball the installation from Mac OS X and unzip it on the alternate file system (using NFS or Samba, depending on source), or • using the command line, copy the installation from Mac OS X to the network location using the same file system as the destination. • BUG ID 33970 - Using a node, such as Grade, as a custom viewer process outputs a blank Viewer. As a workaround, adjust the Viewer gain control to refresh the Viewer. • BUG ID 22062 - Nuke doesn't currently give the option to restore the autosave of an unsaved script, except when Nuke is run from the command line. • BUG ID 13638 - The following graphics cards are not currently supported for Mac: • ATI Radeon X1600 • ATI Radeon X1900 Users with these cards are able to render from the command line, but in GUI sessions, the Node Graph renders incorrectly due to a requirement of OpenGL 2 drivers. • BUG ID 12048 - Nuke crashes if you activate screen sharing when there is no screen plugged in.
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RELEASE NOTES FOR NUKE 9.0V3 | KNOWN ISSUES AND WORKAROUNDS



• BUG ID 11776 - Node text appears aliased, unclear, or garbled at certain zoom levels.



ModelBuilder • BUG ID 41352 - Setting the segments control to a negative number causes Nuke to crash. • BUG ID 41148 - Editing geometry UVs and then switching the Viewer to look at the geometry through a ScanlineRender node causes Nuke to crash.



Monitor Out • BUG ID 40942 - AJA Io Express: Enabling monitor output causes Nuke to crash. • BUG ID 40905 - Decklink 4k Extreme: Enabling monitor out immediately produces audio interference. • BUG ID 37700 - AJA Kona LHe+ 2k formats are not displayed correctly.



OCIO • BUG ID 40033 - Adding an OCIOCDLTransform that references certain .ccc files and clicking select occid causes Nuke to crash.



Particles • BUG ID 41259 - ParticleCache: Setting emit from > points and connecting the emit input to geometry, does not render all frames to the .nkpc file. • BUG ID 39796 - ParticleCache nodes upstream of ScanlineRender nodes display ParticleCache is out-of-date errors for negative frame numbers. • BUG ID 39210 - ParticleCache: Error messages displayed when read from file is toggled on and off are not reliably cleared when rendering through ScanlineRender. • BUG ID 37254 - The progress bar does not cancel if you scrub to a frame that has already been calculated within the particle system. • BUG ID 18268 - Enabling color from texture always renders a solid white alpha for the texture. • BUG ID 17520 - Geometry representation textures are displayed even when display is set to off. • BUG ID 17243 - Using sprites instead of geometry representations causes particles to render behind the 3D grid lines.



Pixel Analyzer and Scopes • BUG ID 43485 - Scopes: Disabling Preferences > Scopes > Include viewer colour transform with a scope present in the workspace causes Nuke to crash. • BUG ID 39180 - Scopes: Switching to a layout with a scope window, while rendering, forces the Viewer bounding box to 1x1 for that frame. • BUG ID 36508 - Scopes do not currently update when zooming into the Viewer. • BUG ID 36491 - Scopes clip color values between 0 and 1 when Preferences > Scopes > Include viewer color transforms is enabled.
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RELEASE NOTES FOR NUKE 9.0V3 | KNOWN ISSUES AND WORKAROUNDS



PrmanRender • BUG ID 27648 - After a security update for Mac OS X, Nuke is unable to load the PrmanRender plug-in when in GUI mode. See http://support.apple.com/kb/TS4267 for more information. • In the Nuke camera, the window roll control is not yet mapped to RenderMan.



Python • BUG ID 44296 - Running nuke.scriptOpen() at the same time as creating a Python panel causes Nuke to crash. • BUG ID 40994 - Rendering an Alembic camera using a Python script produces incorrect values when run from the terminal. Run the script from Nuke's Script Editor to avoid this issue. • BUG ID 40645 - Using setInput() within an onCreateCallback doesn't work as expected. • BUG ID 40534 - Using Python to set metadata in ModifyMetadata nodes does not work from the command line. To workaround this issue, run the Python script from Nuke's Script Editor. • BUG ID 39308 - Accessing a node's x and y positions using the xpos and ypos controls reports incorrect values. As a workaround, either call nuke.Node.xpos() or nuke.Node.ypos() first, or ensure no nodes are currently selected in the Node Graph. • BUG ID 38994 - nuke.Node.screenWidth() and screenHeight() are incorrect when a node is first created if it has an autolabel. • BUG ID 8063 - Creating many new nodes with nuke.createNode() and the in-panel argument at default (True) may crash when too many node control panels are created too quickly. The workaround is to pass the in-panel argument as False or else use nuke.nodes.NodeClass() (where NodeClass is the type of node to create) to create the node and then connect it to the currently selected node manually. • BUG ID 6455 - You should not call the Python command nuke.restoreWindowLayout() from the Script Editor as that can cause Nuke to crash. Instead, you can use the same command from your menu.py, restore layouts by selecting Layout > Restore Layout, or use a custom menu or toolbar item. • Nuke sometimes reports errors in Groups and Gizmos, appearing similar to the following: groupName.NodeName.knobname: unexpected 'k' in '0.knobname' The problem is most likely that there is an expression using the input TCL command and doesn't validate that there is an input connected. An example expression: [input parent 0].translate.x The input command returns 0 when it can't find the requested input, which generates an expression of '0.knobname' that doesn't refer to anything. The fix is to restructure the expression to use the value TCL command and specify a default value to return in the case that the expression is invalid. It takes the form: [value [input parent inputnumber].knob defaultValue] Here is the modified example: [value [input parent 0].translate.x 0] The modified example returns 0 in the event that there is no input 0, and no longer results in an error message.
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RELEASE NOTES FOR NUKE 9.0V3 | KNOWN ISSUES AND WORKAROUNDS



• There is a Python syntax conflict when assigning knob names on the fly with nuke.nodes.() if the knob is called 'in'. For example, this gives a syntax error: nuke.nodes.Shuffle(in = 'depth') while this works because 'in' is a string here and not a keyword: sh = nuke.nodes.Shuffle() sh['in'].setValue('depth')



Read and Write • BUG ID 41357 - Writing out multiple frames with OFX plug-ins, such as Reduce_Noise, renders more slowly in Nuke 8 than previous versions. • BUG ID 41006 - The last audio frame of a QuickTime encoded with AAC compression is muted. • BUG ID 40684 - Rendering certain h264 encoded .mp4 files using the mov32 encoder results in color shifts using QuickTime 10.3 codecs. • BUG ID 40533 - There are slight differences in color and sharpness when rendering Alexa footage to ProRes 4444. • BUG ID 40074 - Writing out stereo .sxr files with additional channels does not write out both eyes correctly. • BUG ID 39165 - ReadGeo: When reading in .fbx files, the transform/scale state can become incorrect while toggling the read transform from file in combination with all objects and/or read on each frame. • BUG ID 35614 - For EXR 2.0 files to be backwards compatible with earlier readers, the layer names must not exceed 32 characters in length. As a workaround, open the .exr in Nuke 8.0 and manually (or Pythonically) truncate the names to allow for legal backwards compatibility. • BUG ID 35611 - Writing .exrs with the Write node's interleave control set to channels adds a superfluous main view. • BUG ID 33863 - FBX geometry: Faces on geometry read in from .fbx files are not connected to neighboring faces, leaving gaps in certain circumstances. This issue is particularly visible when using the EditGeo node, which should not allow you to remove faces from the geometry. • BUG ID 27211 - Alembic: The state of the Viewer Lock Frame control is not always honored for .abc files. As a workaround, ensure that ReadGeo > read on each frame is enabled. • BUG ID 21663 - Read: After reading in a stereo/multiview .exr file and choosing not to add new views to the project, subsequent reads of any stereo/multiview .exr files won’t give the option to add new views. • If you have trouble with FBX files, it may be because they were written with an older version of FBX. If they load very slowly, it is also possible that they are ASCII rather than binary. To get around these problems, you can use the FBX converter on the Autodesk website. It converts between various different formats, including older FBX versions, ASCII, and binary, and is available on Windows, Mac OS X, and Linux. To download the FBX converter: 1. Go to http://usa.autodesk.com/adsk/servlet/pc/item?siteID=123112&id=10775855. 2. Scroll down to FBX Converter and click on one of the links to start the download.
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RELEASE NOTES FOR NUKE 9.0V3 | KNOWN ISSUES AND WORKAROUNDS



• BUG ID 41334 - Alembic: Rendering from the command line with Read from file enabled in the Camera properties and partial geometry selected in a ReadGeo node, causes Nuke to crash.



Render codecs There have been issues where rendering with certain codecs makes Nuke crash. Due to this, we recommend the following: • If you're using the Sorensen Video codec, it's recommended you use the Sorensen Video 3 codec instead. If you're unable to switch to Sorensen Video 3, try using a format smaller than 2K for better performance. • If you're experiencing crashes with Cineform HD, try updating your Cineform codec to version 5 or above. You may need to download the Neoplayer at http://estore.cineform.com/neoplayer.aspx. • If you're using Avid Meridien, you should only write out in NTSC and PAL.



Roto/RotoPaint Open Splines • BUG ID 42997 - Rendering artifacts can occur if the feather control is used in conjunction with the feather handles in the Viewer. • BUG ID 42995 - Stereo: Adding an open spline creates the spline in the left view only by default. As a workaround, select the shape and then manually change the Properties view control to include both views. • BUG ID 42991 - Python API: Moving points on an open spline using Python causes Nuke to crash. • BUG ID 42932 - Rendering artifacts can appear where the spline hull crosses over itself with negative feather values. • BUG ID 42422 - Rotating the tangent of an end point occasionally causes the hull to behave erratically. • BUG ID 42413 - Holding Ctrl/Cmd to move a point's tangent handles independently causes defects in the hull or feather. • BUG ID 42412 - Changing the Viewer overlay visibility, such as from always to never, occasionally produces artifacts in the spline's hull. • BUG ID 42390 - It is not possible to increase the width for individual points if the overall width is set to 0. • BUG ID 42387/42310 - Cusped points occasionally cause hull rendering artifacts. • BUG ID 41445 - Drawing splines with 180º bends causes rendering glitches. • BUG ID 40962 - Animated splines with varying width and feather occasionally contain slight rendering glitches inside the hull. • BUG ID 40433 Roto Open Splines - Shape of hull/feather curve can look incorrect when width changes greatly from one point to the next • BUG ID 36219 - The Select Feather Points tool does not work consistently between the Open Spline and Bezier tools.



Other Roto/RotoPaint Bugs • BUG ID 41966 - PlanarTracker: Layers in the shapes list are deselected when changing Roto tool. • BUG ID 41917 - RotoPaint shape colors don't change when expression linked to another RotoPaint color.
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RELEASE NOTES FOR NUKE 9.0V3 | KNOWN ISSUES AND WORKAROUNDS



• BUG ID 37062/40607 - Certain scripts cause Nuke to crash when opening the Roto properties. • BUG ID 32459 - RotoPaint: Undoing a point move that created a keyframe doesn't currently undo the keyframe creation. • BUG ID 32450 - RotoPaint Stereo: Attempting to undo mulitple split-control transforms on the same shape reverts the shape to its original position. • BUG ID 31552 - Point handles for paint strokes, whose lifetime doesn’t extend to the current frame, disappear when drag-selected. As a workaround, select the shape in the curves list to re-display the points. • BUG ID 30920 - Expression linking extra matrices in the Transform tab doesn’t work as expected. NOTE: This also applies to SplineWarp matrices. • BUG ID 30551 - Several levels of smoothing applied to one shape are carried over to subsequent shapes for a single smooth operation. • BUG ID 29170 - The cut, copy, and paste keyboard shortcuts don't work for entries in the curves list. • BUG ID 28838 - Gizmos from Nuke 6 containing Roto/RotoPaint nodes should be recreated in Nuke 8, but bear in mind that they won’t be backwards compatible with Nuke 6 once converted, unless you follow the instructions below: Nuke 6 scripts containing Roto display a conversion prompt when you open them in Nuke 8: • Click Save As to convert the script to the Nuke 8 Roto format, or • Click Ignore to load the Nuke 6 format into Nuke 8. You might select this option if: - You don't intend to make any changes, or - You want to overwrite the file with a Nuke 7 and 8 only Roto format when saving. If you want Nuke 8 scripts to load in Nuke 6, use the convertToNuke6 or convertDirectoryToNuke6 Python functions when running Nuke 8 in terminal only mode: NOTE: The conversion functions cannot convert stereo-split curves as they are not supported by Nuke 6. • To convert individual .nk scripts: convertToNuke6(fromScript, toScript, overwrite = False) • To convert all .nk scripts in a given directory: convertDirectoryToNuke6(fromDir, toDir, matchPattern =.*\.nk, overwrite = False) NOTE: The pattern is a regular expression. An example single script conversion and rename to the same directory, from the command line (terminal): $ /Nuke8.0v1 -t >>> import nuke.rotopaint >>> nuke.rotopaint.convertToNuke6(/tmp/myRoto8.nk, /tmp/myRoto6.nk)
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• BUG ID 26855 - The undo and redo buttons in the Properties panel didn’t work as expected and have been disabled. The workaround is to use the undo (Ctrl/Cmd+Z) and redo (Ctrl/Cmd+Y) keyboard shortcuts or the Edit menu instead. • BUG ID 21361 - Artifacts are produced until mouse up when painting over a stroke on another frame. • BUG ID 11524 - Adding strokes/shapes in RotoPaint is slow when there is another RotoPaint after it. • BUG ID 9238 - Painting on Mac OS X and Linux is slower when the paint cursor is near the edges of the screen. • The foreground onion skin overlay updates as you paint, rather than only updating with the new stroke on pen up. • It is not currently possible to clone RotoPaint nodes. • Interactivity of laying down strokes/shapes in the Viewer may be faster when motion blur is disabled on the layer you are working in.



ScanlineRender • BUG ID 38329 - Deep renders from ScanlineRender currently ignore the ScanlineRender's bg input. • BUG ID 38205 - Deep: Depth, motion, position, and normals information is occasionally incorrect in semi transparent areas. • BUG ID 37967 - Deep: Geometry with alpha 0 renders black when the deep output is converted to an image.



Text • BUG ID 43561 - Adding Text with a large bounding box, with a Transform in the script, causes Nuke to crash when scrubbing the playhead. • BUG ID 39556 - In text edit mode, it is not currently possible to edit text attributes when the Viewer overlay is disabled. • BUG ID 39552 - Transforming animation groups using an expression-linked Transform node does not work as expected. As a workaround, expression link the translate x and y controls separately. • BUG ID 39483 - Highlighting text in the message field and Viewer is not always synchronized correctly. As a workaround, scrub the playhead to a different frame to update the highlighted text. • BUG ID 39414 - Text entry in the message field occasionally requires multiple undo operations to remove text. • BUG ID 39291 - Splitting the transform control on the Group tab splits all controls. • BUG ID 39239 - Transforming a character generated from an expression, and then going to a frame where the character no longer exists, results in the transformation being lost. • BUG ID 39130 - Splitting the message field does not work as expected. • BUG ID 38789 - Viewer toolbar controls steal cursor focus. • BUG ID 38425 - The undo history becomes unreliable when the panel focus changes. • BUG ID 36372 - Selecting a TCL expression in the message field doesn't always select the result in the Viewer.
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Tracker • BUG ID 40542 - After tracking and centering a track, the Viewer no longer caches when playing back the tracked frames. As a workaround, you can enable full frame processing, though this may increase render times. • BUG ID 40038 - Ctrl/Cmd clicking in the Viewer to select a pixel and then adding a track, sets the tracking anchor coordinates to 0,0. • BUG ID 39225 - Moving tracking anchors is occasionally unresponsive and jerky. • BUG ID 39200 - Holding Shift and clicking tracks in the Viewer doesn't add to the current selection. • BUG ID 38356 - The zoom window occasionally doesn't update correctly when scrubbing between frames. • BUG ID 32353/32359 - Right-clicking on a point in the Viewer doesn’t always update the available Link to > Tracker linkingdialog or Tracker options. As a workaround, close and re-open the Roto/RotoPaint properties panel to update the Link to menu. • BUG ID 29382 - Tracking keyframes with different sized patterns doesn’t work as expected. As a workaround, keyframe patterns should, where possible, be of comparable sizes.



Warpers • BUG ID 32340 - SplineWarp: Using Ctrl/Cmd+drag to create rectangles and ellipses doesn't display an overlay until pen-up. • BUG ID 32083 - SplineWarp: Deleting all but one point on a curve resets its correspondence points to 0,0, which cannot be undone. • BUG ID 32082 - SplineWarp: Correspondence points are too sensitive when control points are removed. • BUG ID 32079 - SplineWarp: Moving correspondence points on curves with no keyframes cannot currently be undone. • BUG ID 30429 - SplineWarp: Transform links are not maintained when the source curve is moved to a new layer. • BUG ID 31322 - SplineWarp/GridWarp: Preview doesn't handle upstream transforms correctly. • BUG ID 20000 - GridWarp: When using cropped input, moving control points causes the Viewer to display the cropped image and the black area between the crop box and the format when merged over a background. • BUG ID 19995 - GridWarp: Locked source and destination grids still allow adding and removing grid lines. • BUG ID 19835 - SplineWarp/GridWarp: The Viewer LUT is incorrect in morph mode, when mix is set at an intermediate value. • BUG ID 19755 - SplineWarp: Placing correspondence points at each end of an open spline causes rendering problems. • BUG ID 19565 - GridWarp: The Viewer does not show the correct mix amount when in morph mode with mix set at an intermediate value. • BUG ID 19386 - GridWarp: All keyframes are removed from the Dope Sheet after undoing, rather than just the latest, and the keyframes remain on the timeline and in the properties. • BUG ID 19148 - SplineWarp: Rendering fails if a curve is reduced to a single point.



17



RELEASE NOTES FOR NUKE 9.0V3 | KNOWN ISSUES AND WORKAROUNDS



• BUG ID 19079 - SplineWarp: The C keyboard shortcut does not currently select the Add Correspondence Point tool. • BUG ID 18712 - GridWarp: The timeline currently shows both source and destination keyframes, even if a grid is not visible in the Viewer. • BUG ID 18709 - GridWarp: Rotating the transform jack with both grids selected, but in different positions, does not undo as expected. • BUG ID 18342 - SplineWarp: The spline keyframe + button does not add keys to the Curve Editor or Dope Sheet. • BUG ID 18304 - GridWarp: Existing control point keyframes are not cleared when you draw a new grid using the Draw Boundary Viewer button. • BUG ID 18019 - GridWarp: You cannot select all grid points in the Curve Editor using Ctrl/Cmd+A shortcut. • BUG ID 18012 - GridWarp: The grid can flicker between white and grey when zooming in and out of the Viewer, particularly when the grid is subdivided. • BUG ID 17697 - GridWarp: In stereo mode, the right view is labelled as default when you split controls into separate views.



Windows only • BUG ID 44185 - Pasting a file path into Nuke's Script to open file browser and pressing Return occasionally causes Nuke to become unresponsive or crash. • BUG ID 41471 - Viewing an .exr through a LensDistortion node is slow to render in the Viewer. • BUG ID 40762 - Python: The QtWebKit DLL does not load correctly. • BUG ID 40407 - When using a tablet, Nuke does not automatically switch to Eraser mode when you use the erase end of the pen. • BUG ID 39636 - QuickTime: The Blackmagic 10 bit (v210) codec defaults to the YCbCr 8-bit 422 (2vuy) pixel format due to a bug in the codec, resulting in solid green frames. As a workaround, manually set the pixel format to b64a RGB to preserve image fidelity. • BUG ID 35800 - Scopes: The alpha channel doesn't update correctly when modified through a node, such as Primatte or Shuffle, even after the node is removed from the Node Graph. • BUG ID 28921 - Changing the 3D selection mode does not update until you click in the Viewer.



Miscellaneous known issues • BUG ID 42899 - Denoise: Certain scripts containing Denoise and Copy nodes cause image corruption. • BUG ID 42339 - The Modo Viewer control scheme (Preferences > Viewers > 3D control type) does not work as expected. • BUG ID 42240 - Setting a channel with a non-standard name to use as the Viewer's alpha channel doesn't work as expected. • BUG ID 41450 - AppendClip forces upstream nodes to re-evaluate on every frame. • BUG ID 41411 - Loading a script from a disconnected network drive creates an empty script with the same name as the file path to the original.
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WARNING: If you save this empty script when the network drive is reconnected, the original is overwritten. • BUG ID 41122 - MatchGrade: Match Different Clip mode does not allow you to set keyframes on the Target for .mov clips with a frame range offset. • BUG ID 41032 - Disconnecting the image input at the top of a node tree containing a Denoise node upstream of an OFX node causes Nuke to crash. • BUG ID 40617 - Some filter nodes, such as Erode (fast), are caching more slowly than in previous versions. • BUG ID 40321 - LensDistortion: Camera presets, set using the wrench icon in the properties panel, cannot be shared between major releases. • BUG ID 39459 - Virtual Sliders: Clicking the left-mouse button, while holding down the middle-mouse button, pastes values into the control. • BUG ID 39407 - Project3D: The node class name has changed to Project3D2. As a result, the NukeMari bridge won't work unless all instances of Project3D are renamed appropriately in the mari_bridge.py file. • BUG ID 39365 - The Viewer headlamp control can not currently be managed using expression links. • BUG ID 39287 - Plug-ins: Loading scripts with plug-ins compiled against older versions removes the nodes from the Node Graph. • BUG ID 39260 - Custom knobs on Groups and NoOp nodes cannot be retimed. • BUG ID 39122 - Switching the Viewer to wipe mode and wiping between inputs with different format sizes causes corruption and constant refreshing in the Viewer. • BUG ID 38929 - File Browser: Items in the favorites/file list get highlighted incorrectly on mouse over. • BUG ID 38713 - Capture: Roto opacity and feather settings are not included in captured images. • BUG ID 35976 - Some CUDA code runs in render mode, even when the --gpu argument is omitted. You can disable all CUDA code by setting the FN_NUKE_DISABLE_CUDA environment variable to 1. • BUG ID 35661 - Capture: Capturing the Viewer with a custom file path saves the file path in the script, resulting in error when the path doesn't exist: Flipbook render failed: viewerCaptureOp: Cannot write to specified path • BUG ID 35659 - Capture: Capturing a 3D scene containing lights produces Viewer flashes in the captured images. • BUG ID 32856 - PositionToPoints: Textures occasionally disappear during playback or when mousing over the Viewer. • BUG ID 32666 - FrameHold nodes have no effect on Deep nodes. • BUG ID 32628 - DeepToPoints: Command line rendering appears to calculate renders even when render is set to off. • BUG ID 32497 - The R3D parameter labels in Nuke aren’t entirely consistent with REDCINE-X and Hiero. • BUG ID 32219 - DepthToPosition: Reading depth information from the same layer as the output layer produces corrupt output. As a workaround, shuffle the depth information to an alternate layer.
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• BUG ID 32118 - Card3D: When motionblur is enabled in the properties, FrameHold and TimeOffset nodes are ignored when connected to the cam or axis inputs. • BUG ID 31803 - Using Shift+drag on a control’s animation icon only copies the value for the current frame, not the entire expression. • BUG ID 31714 - In the Viewer settings, enabling 3D > show_prim_bbox does not display individual bounding boxes for polymesh primitives. • BUG ID 31310 - TimeOffset: Checking reverse input doesn’t affect cameras, lights, or axes. • BUG ID 31238 - RAM cache: Any action that changes a frame’s hash value, it’s unique identifier, causes the cache to release. Actions such as adjusting the Viewer Gamma, Gain, or channels dropdown affect the frame hash. • BUG ID 30502 - Copying and pasting spline keys does not work as expected in the Dope Sheet. NOTE: This known issue only applies to Roto and SplineWarp keys. • BUG ID 30256 - Script Editor: Flagging a control as invisible using setFlag() is not honored when the node is copy/pasted in the Node Graph. • BUG ID 30173 - Manipulating 3D handles in the 2D Viewer is unreliable. • BUG ID 29677 - Connecting a FrameHold node to an animated Camera and connecting both to a Scene node only displays the animated Camera in the Viewer. There should be two cameras: one static and one animated. • BUG ID 29083 - Using Create Camera in the 3D Viewer only sets position and rotation. The focal length of the new camera does not match that of the Viewer camera. • BUG ID 28291 - Nuke crashes on startup if the disk cache location set in the Preferences is no longer available. • BUG ID 20431 - CameraTracker: It’s not possible to pick colors in the Viewer with the control panel open. • BUG ID 20204 - Multitexturing: When Preferences > Viewers > Multiframe is enabled, increasing downrez in the Viewer toolbar can cause textures to flicker in the 3D Viewer. You can switch back to Classic mode or avoid using proxy in 3D to workaround this issue. • BUG ID 19933 - ReadGeo: Geometry occasionally doesn't display as a solid until you click in the Viewer. • BUG ID 19185 - Attaching an FBX ReadGeo to the Viewer occasionally causes a slight graphical glitch in the Properties panel. • BUG ID 18649 - The transform jack is currently scaling incorrectly from the corner pivot point. • BUG ID 12505 - Motion Vector output has been improved, but still doesn't work properly because some large polygons are clipped by the front camera plane. You can minimize this effect by increasing the geometry tessellation max parameter. • BUG ID 12424 - Ultimatte: Overlays are not updating correctly or reverting when panning or zooming. • BUG ID 11620 - In the 3D Viewer, there is currently a conflict between 3D geometry selection and points drawn with RotoPaint. This only occurs if you have two Viewers open, one in 2D mode and the other in 3D mode, and you have the panel for the RotoPaint visible. • BUG ID 9521 - Currently, the Nuke Viewer cannot cache very large plate sequences in float. The limit per frame is 50MB. If your frames are larger than this, you may need to switch to proxy mode for the caching to work.
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• BUG ID 5922 - At the moment, cloning does not work properly with all OFX nodes. This affects, but is not restricted to, any nodes that have an analysis pass. • BUG ID 5690 - Windows run-time libraries are not packaged properly with Nuke. Nuke runs correctly from a network install on Windows without specifically installing the run-time libraries, though we still recommend that you do so as there are still some minor problems without them. • BUG ID 5083 - Flipbooking the output of the Anaglyph node asks which view you want to render. This question is unnecessary as the result is an anaglyph image. Irrespective of what view you choose, the flipbook output is the same. • File types in Windows and Mac OS X are associated with the standard version of Nuke by default, so if you save a script on NukeX using features that are only included in NukeX (such as CameraTracker or FurnaceCore) and then double-click on the script icon to open it, it opens in standard Nuke instead of NukeX. • CameraTracker: Canceling lens distortion initialization results in corrupt tracks. • 3D Camera: If you want to navigate through the 3D point cloud created by the CameraTracker node when using Create Scene: • Select the Camera that was created in the 3D view when using the Create Scene button. • Press F to focus on the selected Camera. You can now navigate around the cloud. Do not try to focus (using F) on the point cloud. The resulting tumble camera movement is likely to be jumpy. • Plug-ins installed using the Nuke Plug-in Installer may not work correctly as they were complied against an earlier version of Nuke.
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Developer Notes Here are the changes relevant to developers. See Help > Documentation from the Nuke menu bar for more information. NOTE: Node Class() names occasionally change between major releases, such as Nuke 7 to Nuke 8. While these changes do not affect legacy scripts, you may not get the results you were expecting if a node class has been modified. The toolbars.py file, used to create Nuke's node toolbar, contains all the current node class names and is located in /plugins/nukescripts/ for reference. As an example, between Nuke 7 and Nuke 8, the Text node Class() changed from Text to Text2. In the toolbars.py file for the two releases, the entries for the Text node appear as follows: m.addCommand("Text", "nuke.createNode(\"Text\")", icon="Text.png") m.addCommand("Text", "nuke.createNode(\"Text2\")", icon="Text.png")



New Features There are no new features in this release.



Feature Enhancements There are no feature enhancements in this release.



Bug Fixes There are no bug fixes in this release.
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Release Notes for Nuke 9.0v2



Release Date 11 December 2014



Qualified Operating Systems • Mac OS X 10.7 (Lion), 10.8 (Mountain Lion), 10.9 (Mavericks) NOTE: Nuke is expected to function correctly under Mac OS X 10.9 (Mavericks), but we are seeing UI performance degradation compared to previous OS X versions. We are working on resolving these issues. • Windows 7 64-bit and Windows 8 64-bit • CentOS/RHEL 5 and CentOS/RHEL 6 Other operating systems may work with Nuke, but have not been fully tested. If you have any problems with a particular operating system, please contact [email protected].



Hardware Requirements for Real-time Playback The following is a list of recommended hardware configurations that The Foundry have certified for 4K real-time playback (see the note below). Please note that 4K playback may also work on other machine configurations, but the ones listed below are ones which have been tested. NOTE: The 4K playback requirements listed here refer to streaming playback for 10-bit DPX rgb files at 30 fps, 4K UHD, with audio and a monitor output device enabled. Other file formats may also play back at 4K and above, given sufficient disk read speeds.



Mac Certified Box Hardware • Mac Pro, Late 2013
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• Software OS X 10.9.5 (13F34) • 3.5 GHz 6-Core Intel Xeon E5 • GPU - FirePro D500 3072 MB • 32 GB 1867 MHz DDR3 ECC



Monitor Output • BlackMagic: UltraStudio 4K (Thunderbolt 2) • Desktop Video Software Driver 10.3 • Thunderbolt 2 • Download Link: https://www.blackmagicdesign.com/support/download/35045/Mac%20OS%20X OR • AJA: IO4K (Thunderbolt 2) • Mac Driver v10.6 (Firmware version 'IO4K (4K mode)' • Download Link: http://www.aja.com/assets/support/files/2697/en/AJA_Io4K_10_6.zip WARNING: T-Tap is not currently supported.



Windows Certified Box Hardware • Windows 7 • 2 x 3.4 GHz, 8-Core • NVIDIA Quadro K5200, NVIDIA Driver 340.x • 32 GB RAM



Monitor Output • BlackMagic: Decklink 4K Extreme OR Decklink 4K Studio, • Desktop Video Driver 10.3 • Download Link: https://www.blackmagicdesign.com/support/download/35045/Windows OR • AJA: Kona 3G OR Kona 4 • AJA Hardware Driver v10.5.2 - Windows (64-bit) • Download Link: http://www.aja.com/assets/support/files/2620/en/AJA_Win_Drivers-10.5.2-x64.msi.zip



Linux Certified Box Hardware • CentOS/RHEL 6.5, • 2 x 3.4 GHz, 8-Core • NVIDIA Quadro K5200, NVIDIA Driver 340.x
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• 32 GB RAM



Monitor Output • BlackMagic Decklink 4K Extreme, Decklink 4K Studio • Desktop Video Driver 10.3 • Download Link: https://www.blackmagicdesign.com/support/download/35045/Linux



Disk Storage and Read/Speeds • Windows/Linux: HP Z Turbo Drive OR Fusion ioFX, PCIe cards • Mac OS X: LaCie Little Big Disk 1TB, Thunderbolt 2 • Network attached storage: Minimum of sustained 1GB/s read speed NOTE: See the Nuke User Guide Installation and Licensing section or the online help here, regarding example formats and data rates.



Requirements for GPU Acceleration If you want to enable Nuke to calculate certain nodes using the GPU, there are some additional requirements. You need to have: • an NVIDIA GPU with compute capability 2.0 (Fermi) or above. A list of the compute capabilities of NVIDIA GPUs is available at www.nvidia.co.uk/object/cuda_gpus_uk.html NOTE: The compute capability is a property of the GPU hardware and can't be altered by a software update. With graphics drivers capable of running CUDA 4.2 or above. NOTE: In order to use R3D GPU debayering in the Compositing environment, CUDA 6.0 (or higher) is required. See Release Notes for Nuke 9.0v2 for more information. • On Windows and Linux, CUDA graphics drivers are bundled with the regular drivers for your NVIDIA GPU. Drivers from April 2012 onward support CUDA 4.2. Go to http://www.nvidia.com/Download/Find.aspx?lang=en-us for more information. • On Mac, the CUDA driver is separate from the NVIDIA graphics driver and must be installed, if you don't have it already. The minimum requirement for CUDA 4.2 is driver version 4.2.5, which can be downloaded from www.nvidia.com/drivers. NOTE: We recommend using the latest graphics drivers, where possible, regardless of operating system.
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• an AMD FirePro GPU on late 2013 Mac Pro 6.1, running OS X 10.9.3 'Mavericks', or later (see below and the Blink API documentation for caveats on CPU/GPU result consistency on Mac Pros).



Late 2013 Mac Pro Only Nuke Studio supports GPU-enabled nodes on the late 2013 Mac Pro 6.1 (running OS X 10.9.3 'Mavericks', or later), including a new Enable multi-GPU support option. When enabled in the preferences, GPU processing is shared between the available GPUs for extra processing speed. NOTE: Due to outstanding Mac OS X issues with OpenCL, GPU processing is not currently available on late 2013 Mac Pro 6.1, in the following circumstances: • If you're running an earlier version of Mac OS X than 10.9.4 'Mavericks', Kronos and MotionBlur do not support GPU acceleration. • If you're running an earlier version of Mac OS X than 10.9.5 'Mavericks' and processing images greater than 4 mega pixels resolution, VectorGenerator, Kronos, and MotionBlur do not support GPU acceleration.



Launching and Licensing Information • Nuke can be run on the command line from the installation directory without any arguments. For example, on Windows: C:\Program Files\Nuke9.0v2\Nuke9.0.exe NukeX and Nuke Studio can be run on the command line from the installation directory using the --nukex and         --studio arguments. For example, on Windows: C:\Program Files\Nuke9.0v2\Nuke9.0.exe --studio • NukeX requires nukex_i and nuke_i licenses with valid maintenance. • Nuke Studio requires nukestudio_i, nukex_i, and nuke_i licenses with valid maintenance.



New Features There are no new features for this release.



Feature Enhancements This section covers any feature enhancements that have been made in this release.
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Create Comp • BUG ID 46677 - Ctrl/Cmd+double-clicking a Nuke comp (in the bin or timeline view) now opens up the comp in a new instance of NukeX. You can also do this by right-clicking the Nuke comp and choosing Open In > New Nuke Session.



PlanarTracker • BUG ID 46696 - The warp matrix in PlanarTracker has been improved to be more accurate. • BUG ID 46697 - The PlanarTracker search along the lesser (horizontal) dimension has been improved for tracking footage with extreme aspect ratios.



Read and Write • BUG ID 44999 - Build Track: A new checkbox, Create Comp Clips, has been added to the Build Track From Export Tag dialog so that you can choose whether you want to import the .nk script or the renders from the .nk script. • BUG ID 45366 - Added read support DNxHD QuickTime movies with the 64-bit Mov Reader. • BUG ID 46481 - Added support for encoding DNxHD QuickTime movies with the 64-bit Mov Writer. • BUG ID 46650 - The Read node now includes the name of the compression type in the .exr metadata. • BUG ID 46651 - Added support for encoding .exr files using b44a compression. • BUG ID 46764 - 64-bit Mov Writer: Added support for encoding the alpha channel with the Apple ProRes 4444 codec.



Bug Fixes This section covers any bug fixes that have been made in this release.



Annotations • BUG ID 43904 - Nuke Studio incorrectly allowed you to add annotations to a locked track.



Blink Script • BUG ID 41421 - Scrolling in the Kernel Source script editor did not work. • BUG ID 44621 - The error message, displayed when loading a plug-in that was built for an incompatible Blink version, was not clear.



Create Comp • BUG ID 42873 - The Project Root dialog for Create Comp was not using the Nuke default file browser.



27



RELEASE NOTES FOR NUKE 9.0V2 | BUG FIXES



• BUG ID 46397 - Switching between two up-to-date, rendered versions of a Nuke comp incorrectly changed the Nuke comp color to yellow.



Frame Server • BUG ID 45420 - The path remap argument (--remap) did not work when mapping between Windows and Mac OS X or Linux file systems. • BUG ID 46576 - The Frame Server was very slow and dropped frames when rendering multiple Nuke comps. • BUG ID 46790 - Using the Frame Server across platforms did not work as expected.



Keyboard Shortcuts • BUG ID 44498 - The 'close all properties keyboard' shortcut (Ctrl/Cmd+Shift+A) did not close all panels in the Properties pane. • BUG ID 45460 - Changing the channel or layer using the Page Up and Page Down keyboard shortcuts did not reflect the changes in the channel/layer dropdowns. • BUG ID 46565 - Pressing Enter on the keyboard numeric keypad, when the Viewer had focus, did not switch focus to the current frame control.



Monitor Out • BUG ID 46515 - Changing the Monitor Output to a 4K UHD mode occasionally caused Nuke Studio to crash. • BUG ID 46541 - Playing-back using Monitor Output and then setting an out point caused audio to be out of sync.



OCIO • BUG ID 44921 - After setting an OCIO config file and restarting Nuke Studio, the ColorTransform menu did not display or apply the default value. • BUG ID 46716 - A role was added to OCIO to determine the default LUT, but it was not necessary as there were existing tools in place for that purpose.



PlanarTracker • BUG ID 46218 - With several PlanarTracker layers created, selecting one of the tracked shapes in the Viewer did not select the PlanarTracker layer. • BUG ID 46532 - With a lifetime set on a PlanarTracker shape, tracking outside of the range caused Nuke Studio to crash.



Preferences • BUG ID 40672 - The last viewed sub-menu was not restored when the Preferences were re-opened. • BUG ID 44503 - The Panels > Viewer (Sequence) > guides control did not display overlays as expected. • BUG ID 44544 - The preference Automatically rescan versions when moving off end of the version list was missing from Nuke Studio's Preferences.
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• BUG ID 46645 - Nuke 9.0 was not loading preferences that were stored in Nuke 8.0. • BUG ID 46769 - The Viewer tab in the Preferences dialog was missing the texture size and texture mode labels for the associated dropdown menus. • BUG ID 46817 - The default number of threads per reader control was set to 2, which was insufficient for 4K .dpx playback. This default has been increased to 4 for machines that have more than four physical cores. NOTE: If required, this setting can be adjusted for different formats, such as .jpeg and .tiff files. • BUG ID 46681 - The background renders preference was set to start background renders on Comp save by default instead of don't auto-start background renders.



Read and Write • BUG ID 44617 - The column dividers in the Export Queue dialog were not visible for resizing the columns. • BUG ID 44780 - If you moved the Write node into a new folder in the Export dialog, it was not automatically included in the exported Nuke script. • BUG ID 46540 - The mov64Reader only read in the first frame timecode. • BUG ID 46543 - EDL Import: Importing clips with negative retimes resulted in them having the incorrect source timecodes. • BUG ID 46598 - Match Media: Matching media from the a certain project caused Nuke to become unresponsive. • BUG ID 46626 - Exporting a preset without a file extension did not produce an error and did not render. • BUG ID 46630 - Changing the export preset Render with control from Frame Server to Single RenderProcess and back again, produced errors in the terminal output. • BUG ID 46775 - ARRIRAW: Nuke Studio was unable to read certain .ari files at a specific resolution. • BUG ID 46715 - The mov64Reader was not reading in metadata correctly in all instances.



Script Editor • BUG ID 40940 - The echo commands to output window preference was not working as expected. • BUG ID 46121 - The Python commands for adding favorite directories in the file browser did not work.



Soft Effects • BUG ID 44965 - Text: In a Text soft effect's properties, the group context menu – accessed by right-clicking on a group in the Groups tab – was missing several options. • BUG ID 46408 - Text: After adding a Text soft effect, clicking in the Viewer, and then changing frames, the cursor was placed in the incorrect position. • BUG ID 46416 - Timewarp: The result of Timewarp was sometimes incorrect when applied to a clip that had been retimed and then trimmed. • BUG ID 46435 - Grade: If the gamma value of the Grade soft effect was set to zero, the timeline Viewer showed incorrect results.
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• BUG ID 46719 - Text: Copying and pasting a Text soft effect occasionally caused incorrect formatting of the characters. • BUG ID 46749 - Timewarp: Deleting a track item and a TimeWarp soft effect simultaneously, occasionally caused Nuke Studio to crash. • BUG ID 46865 - Pasting a soft effect onto two track items with a dissolve between them incorrectly treated them as one track item, which caused an error in the soft effect.



Spreadsheet • BUG ID 44223 - Opening a project in the Spreadsheet using the right-click menu did not automatically link it to the timeline.



Timeline • BUG ID 44140 - Dragging a clip onto the timeline to create a sequence, and then undoing it, incorrectly cleared the associated linked panels. • BUG ID 45672 - Scopes: The Include viewer color transforms preference was not working as expected. • BUG ID 45695 - Sequences: The timeline playhead remained in its previous position when you created a new sequence. • BUG ID 46445 - Trimming a 4GB animation clip (mov64) caused Nuke Studio to crash. • BUG ID 46475 - Time Display: Opening a clip in Timeline View, changing the Time Display to Frames, and setting a new current frame did not work as expected. • BUG ID 46524 - Retiming: After retiming and then trimming, the timeline Viewer occasionally showed an incorrect first frame.



Undo • BUG ID 46233 - PlanarTracker: Completing a track removed any previous actions from the undo stack. • BUG ID 46551 - Roto: Undoing numerous actions including creating a shape using a Roto node, connecting the Roto node to a Viewer, and moving the Roto node around in the Node Graph, caused Nuke to crash. • BUG ID 46632 - Pressing Return on the keyboard to perform an action was not recorded in the undo stack. • BUG ID 46640 - RotoPaint: Removing a paint stroke created in RotoPaint, using the Delete or Backspace keys, was not recorded in the undo stack.



Viewer • BUG ID 46037 - Viewer Tools: Setting the Viewer playback mode to Bounce did not toggle both play buttons to stop buttons. • BUG ID 46317 - Compositing Viewer: It was difficult to exit the color-picking mode when using the 'display color information' tool above the Viewer.
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ZDefocus • BUG ID 46324 - With the math control in the ZDefocus properties set to depth, objects that were infinitely far away were incorrectly treated as infinitely close. • BUG ID 46555 - When animating the focal plane value, there was noticeable aliasing/jumping between the output images of a ZDefocus node set to use its internal disc filter pattern, and a ZDefocus node set to use an external disc image.



Miscellaneous • BUG ID 6734 - Panel Text Fields: You could not use the middle-mouse button to scroll in panel text fields. • BUG ID 38880 - Colorspace Node: The Colorspace node now supports Rec.2020 primaries. • BUG ID 42641 - Shuffle Node: Inserting a Shuffle node after a Denoise node caused rendering to be slow. • BUG ID 43839 - Nuke Studio UI: With the menu bar in timeline mode, clicking in the compositing toolbar did not switch the menu bar to compositing mode. • BUG ID 46455 - Launching: Launching Nuke from the command line using a subset of a flag caused it to crash. • BUG ID 46656 - Performance: The Copy node was slowing down performance considerably. • BUG ID 46765 - Nuke 9.0 only: Custom panels were not restored correctly. • BUG ID 46867 - Dissolve: Inserting a dissolve between two track items incorrectly applied the format from the first track item to the second track item.



31



RELEASE NOTES FOR NUKE 9.0V2 | DEVELOPER NOTES



Developer Notes Here are the changes relevant to developers. See Help > Documentation from the Nuke menu bar for more information. NOTE: Node Class() names occasionally change between major releases, such as Nuke 7 to Nuke 8. While these changes do not affect legacy scripts, you may not get the results you were expecting if a node class has been modified. The toolbars.py file, used to create Nuke's node toolbar, contains all the current node class names and is located in /plugins/nukescripts/ for reference. As an example, between Nuke 7 and Nuke 8, the Text node Class() changed from Text to Text2. In the toolbars.py file for the two releases, the entries for the Text node appear as follows: m.addCommand("Text", "nuke.createNode(\"Text\")", icon="Text.png") m.addCommand("Text", "nuke.createNode(\"Text2\")", icon="Text.png")



New Features There are no new features in this release.



Feature Enhancements There are no feature enhancements in this release.



Bug Fixes • BUG ID 46491 - Custom Toolbars were not loaded as part of saved workspaces. • BUG ID 46556 - The argument 'nuke.scriptOpen' did not work with remap between Windows and Mac/Linux. • BUG ID 46558 - The openInSpreedsheet argument did not return the destination 'SpreadsheetView' object. • BUG ID 46609 - Python API Documentation: The documentation for the Python function addCommand referred to the contextWidget option for setting the action context instead of shortcutContext.
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Release Date 18 November 2014



Qualified Operating Systems • Mac OS X 10.7 (Lion), 10.8 (Mountain Lion), 10.9 (Mavericks) NOTE: Nuke is expected to function correctly under Mac OS X 10.9 (Mavericks), but we are seeing UI performance degradation compared to previous OS X versions. We are working on resolving these issues. • Windows 7 64-bit and Windows 8 64-bit • CentOS/RHEL 5 and CentOS/RHEL 6 Other operating systems may work with Nuke, but have not been fully tested. If you have any problems with a particular operating system, please contact [email protected].



Hardware Requirements for Real-time Playback The following is a list of recommended hardware configurations that The Foundry have certified for 4K real-time playback (see the note below). Please note that 4K playback may also work on other machine configurations, but the ones listed below are ones which have been tested. NOTE: The 4K playback requirements listed here refer to streaming playback for 10-bit DPX rgb files at 30 fps, 4K UHD, with audio and a monitor output device enabled. Other file formats may also play back at 4K and above, given sufficient disk read speeds.



Mac Certified Box Hardware • Mac Pro, Late 2013
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• Software OS X 10.9.5 (13F34) • 3.5 GHz 6-Core Intel Xeon E5 • GPU - FirePro D500 3072 MB • 32 GB 1867 MHz DDR3 ECC



Monitor Output • BlackMagic: UltraStudio 4K (Thunderbolt 2) • Desktop Video Software Driver 10.3 • Thunderbolt 2 • Download Link: https://www.blackmagicdesign.com/support/download/35045/Mac%20OS%20X OR • AJA: IO4K (Thunderbolt 2) • Mac Driver v10.6 (Firmware version 'IO4K (4K mode)' • Download Link: http://www.aja.com/assets/support/files/2697/en/AJA_Io4K_10_6.zip WARNING: T-Tap is not currently supported.



Windows Certified Box Hardware • Windows 7 • 2 x 3.4 GHz, 8-Core • NVIDIA Quadro K5200, NVIDIA Driver 340.x • 32 GB RAM



Monitor Output • BlackMagic: Decklink 4K Extreme OR Decklink 4K Studio, • Desktop Video Driver 10.3 • Download Link: https://www.blackmagicdesign.com/support/download/35045/Windows OR • AJA: Kona 3G OR Kona 4 • AJA Hardware Driver v10.5.2 - Windows (64-bit) • Download Link: http://www.aja.com/assets/support/files/2620/en/AJA_Win_Drivers-10.5.2-x64.msi.zip



Linux Certified Box Hardware • CentOS/RHEL 6.5, • 2 x 3.4 GHz, 8-Core • NVIDIA Quadro K5200, NVIDIA Driver 340.x



34



RELEASE NOTES FOR NUKE 9.0V1 |



• 32 GB RAM



Monitor Output • BlackMagic Decklink 4K Extreme, Decklink 4K Studio • Desktop Video Driver 10.3 • Download Link: https://www.blackmagicdesign.com/support/download/35045/Linux



Disk Storage and Read/Speeds • Windows/Linux: HP Z Turbo Drive OR Fusion ioFX, PCIe cards • Mac OS X: LaCie Little Big Disk 1TB, Thunderbolt 2 • Network attached storage: Minimum of sustained 1GB/s read speed NOTE: See the Nuke User Guide Installation and Licensing section or the online help here, regarding example formats and data rates.



Requirements for GPU Acceleration If you want to enable Nuke to calculate certain nodes using the GPU, there are some additional requirements. You need to have: • an NVIDIA GPU with compute capability 2.0 (Fermi) or above. A list of the compute capabilities of NVIDIA GPUs is available at www.nvidia.co.uk/object/cuda_gpus_uk.html NOTE: The compute capability is a property of the GPU hardware and can't be altered by a software update. With graphics drivers capable of running CUDA 4.2 or above. NOTE: In order to use R3D GPU debayering in the Compositing environment, CUDA 6.0 (or higher) is required. See Performance Updates for more information. • On Windows and Linux, CUDA graphics drivers are bundled with the regular drivers for your NVIDIA GPU. Drivers from April 2012 onward support CUDA 4.2. Go to http://www.nvidia.com/Download/Find.aspx?lang=en-us for more information. • On Mac, the CUDA driver is separate from the NVIDIA graphics driver and must be installed, if you don't have it already. The minimum requirement for CUDA 4.2 is driver version 4.2.5, which can be downloaded from www.nvidia.com/drivers. NOTE: We recommend using the latest graphics drivers, where possible, regardless of operating system.
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• an AMD FirePro GPU on late 2013 Mac Pro 6.1, running OS X 10.9.3 'Mavericks', or later (see below and the Blink API documentation for caveats on CPU/GPU result consistency on Mac Pros).



Late 2013 Mac Pro Only Nuke Studio supports GPU-enabled nodes on the late 2013 Mac Pro 6.1 (running OS X 10.9.3 'Mavericks', or later), including a new Enable multi-GPU support option. When enabled in the preferences, GPU processing is shared between the available GPUs for extra processing speed. NOTE: Due to outstanding Mac OS X issues with OpenCL, GPU processing is not currently available on late 2013 Mac Pro 6.1, in the following circumstances: • If you're running an earlier version of Mac OS X than 10.9.4 'Mavericks', Kronos and MotionBlur do not support GPU acceleration. • If you're running an earlier version of Mac OS X than 10.9.5 'Mavericks' and processing images greater than 4 mega pixels resolution, VectorGenerator, Kronos, and MotionBlur do not support GPU acceleration.



Launching and Licensing Information • Nuke can be run on the command line from the installation directory without any arguments. For example, on Windows: C:\Program Files\Nuke9.0v1\Nuke9.0.exe NukeX and Nuke Studio can be run on the command line from the installation directory using the --nukex and         --studio arguments. For example, on Windows: C:\Program Files\Nuke9.0v1\Nuke9.0.exe --studio • NukeX requires nukex_i and nuke_i licenses with valid maintenance. • Nuke Studio requires nukestudio_i, nukex_i, and nuke_i licenses with valid maintenance.



New Features Nuke, NukeX, and Nuke Studio Nuke Studio is a new application mode, offering a timeline environment in addition to the nodal, single shot environment Nuke is known for. If you've used Hiero in the past, it essentially offers you Hiero's conforming, project management, playback, and export feature set within the same application as Nuke. This allows entire sequences of shots to be worked on, both in terms of the timeline and the individual shot Node Graphs, and farmed out to other Nuke artists.
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Nuke Studio can be accessed from the relevant shortcut, or using the --studio flag on the command line. When run in Nuke Studio mode, the application uses a separate set of workspaces which include the relevant timeline, Viewer, project, and spreadsheet panels. Source material can be auditioned, timelines edited, Soft Effects applied, comps created, edited, and rendered, and the final spot exported all from within the single package. See Nuke Studio 9 Features for more information.



Nuke and NukeX 9 Features Performance Updates "Just make it go faster". The most common request since we took over Nuke's development. A lot of engineering has been dedicated to making performance boosts across the board. We have significantly increased overall performance in Nuke 9 compared to Nuke 8. For example, improved exrReader and Deep EXR, scene building and sampling in ScanlineRender, and mip-map filters have been added to ScanlineRender. • Nuke now includes R3D GPU debayering if you have CUDA 6.0, or higher, which can significantly reduce decode times for R3D clips read into the Node Graph. You can enable GPU debayering in the Read node's properties, under r3d options, by selecting use cuda if available. • BUG ID 45116 - Mac OS X only: A new global preference (Preferences > Hardware > enable Multi-GPU support) has been added for multi-GPU processing on Late-2013 Mac Pros running 10.9.3 'Mavericks', or later. See Requirements for GPU Acceleration for more information.



Kronos, VectorGenerator, and MotionBlur The Foundry's motion estimation algorithm has been improved, based on Ocula technology, resulting in improvements in vector generation, retiming, and motion blur: • Improved retime quality - less artefacts and smoother warp. • Improved image reconstruction, giving sharper images and less "pulsing" between sharp and blurry results as you move between the original frames. • A new Method dropdown allowing you to choose the interpolation method from Frame, Blend, and Motion. Additional work includes: • New Resampling methods, including Lanczos4 and Lanczos6 for scaling. • New control over retime curves in the input time range, as well as improved range integration, combining to give you concise, intuitive control of your speed ramps. • Considerable effort has gone into making sure that renders processed on the GPU and CPU are 'same-same', meaning the output appears identical, and wherever possible, is identical bit-wise.
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NOTE: In Nuke 9.0, we added support for AMD GPUs on late 2013 Mac Pro 6.1, running OS X 10.9.3 'Mavericks', or later. While, in some cases the bit-wise equality between GPU and CPU holds, for some operations there are limitations to the accuracy possible with this configuration. • A new Channels dropdown has been added to the node properties, allowing you to retime on a sub-set of channels.



OFlow Nuke's OFlow node has benefitted from some of the improvement work done on Kronos and VectorGenerator: • New Resampling methods, including Lanczos4 and 6 for scaling. • New control over retime curves in the input time range, as well as improved range integration, combining to give you concise, intuitive control of your speed ramps. • Considerable effort has gone into making sure that renders processed on the GPU and CPU are 'same-same', meaning the output appears identical, and wherever possible, is identical bit-wise. NOTE: In Nuke 9.0, we added support for AMD GPUs on late 2013 Mac Pro 6.1, running OS X 10.9.3 'Mavericks', or later. While, in some cases the bit-wise equality between GPU and CPU holds, for some operations there are limitations to the accuracy possible with this configuration. • A new Channels dropdown has been added to the node properties, allowing you to retime on a sub-set of channels.



Denoise The Denoise node is now available to use in Nuke, rather than NukeX only.



PlanarTracker PlanarTracker has been integrated into the Roto and RotoPaint nodes on a new Tracking tab, incorporating all the features of Roto and PlanarTracker. Additional work includes: • A pattern-matching algorithm. • A region tracking algorithm which works with featureless areas of footage. • A new luminance shift option for shots where luminance alters within the tracking region. • A CornerPin creation dropdown has been added to the Roto/RotoPaint Tracking tab in the properties panel.



New Image Format Support and QuickTime Improvements Nuke now includes a new mov64 reader and writer, in addition to the mov32 reader and writer from previous releases. You can choose which decoder/encoder to use in Nuke's Read and Write nodes properties:
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• mov32 - uses the full range of QuickTime codecs using the official QuickTime 32-bit SDK, but can be slow to process due to extra complexity during decode/encode. • mov64 - uses its own packing and unpacking and streams decode/encode for extra processing speed, but only supports a sub-set of offical QuickTime codecs. NOTE: Nuke defaults to the fastest decoder/encoder for the codec used in the file - if you're reading in a type supported by the mov64 sub-set, Nuke defaults to that reader/writer. Otherwise, the fallback mov32 reader is used. Nuke is now an Apple Authorized ProRes third-party product and can read and write Apple ProRes 4444 and Apple ProRes 422 on Mac OS X, Linux, and Windows using the mov64 reader at SD, HD, 2K, and UHD resolutions. Apple ProRes 422 includes the HQ, LT, and Proxy formats. NOTE: Full support for Apple ProRes 4444 XQ is scheduled for a later release. An mxfReader has been added for the following codecs: • Avid DNxHD (all 1080p and 720p formats, 4:4:4:4 and 4:2:2 ) • Uncompressed (4:2:2 YCbCr and RGB). • AVCI and DV (AVCI 'unconstrained' variety are not currently supported).



ARRIRAW The ARRI SDK has been updated to version 4.5, which adds several .ari specific controls including lens squeeze and aspect ratio.



OCIO The OpenColorIO library version has been updated to 1.0.9.



Native Flipbook Tool Nuke now features a native Flipbook panel. Clicking the Flipbook this viewer button under the Compositing Viewer now uses an internal real time flipbook Viewer by default.



ScanlineRender Mip-map Texture Filters ScanlineRender now includes several new mip-map filter options providing performance improvement when sampling from large textures. The new filters are listed below from fastest to most accurate: • Nearest • Bilinear • Trilinear • Anisotropic
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Performance Timers Nuke's performance timers have been updated to give more accurate and detailed timing information on all platforms. When performance timing is enabled, timing information is displayed in the Node Graph, and the nodes themselves are colored according to the proportion of the total processing time that was spent in each one, from green (fast nodes) through to red (slow nodes). In addition, new python calls have been added to provide python access to timing information for individual nodes. Alternatively, Nuke can now be run from the command line with the -Pf argument to obtain the full performance profile for a render in XML format. Performance profiling can help you to debug slow scripts and find out where the bottlenecks lie; this new feature was also used internally during the development of Nuke to help us target our performance work most effectively.



Node Improvements • Backdrop nodes now have a Z Order control, allowing you to set the layering of Backdrops within other Backdrops. The Backdrop with the highest Z Order is placed at the front. • All Nuke nodes with a Node tab in their properties now include lifetime controls allowing you selectively enable and disable nodes according to frame range when use lifetime is enabled.



Miscellaneous • The Text node now includes a Shadows tab, allowing you to add drop shadow to text in the Viewer, either as a soft effect or regular node in the Node Graph. Drop shadows incude color, softness (blur), and shrink/expand (dilate) controls. The Text node's general performance has been improved, including enhanced caching. • The Merge node now allows you to merge metadata as well as image data from selected or all inputs using the metadata from dropdown. • Nuke's Read node now includes a Metadata tab showing all metadata associated with the file(s) read in. • BUG ID 43858 - Preferences: The Preferences dialog has been edited for clarity and accuracy.



Nuke Studio 9 Features Soft Effects Soft effects are GPU accelerated effects, which can be added and manipulated directly in the timeline to perform common tasks in real-time. Soft effects are applicable at sequence level, where they appear as a layer above track items on the timeline, and at clip level where they appear as a colored line inside the associated track item. Sequencelevel soft effects apply their effect to whatever is beneath them in the timeline, for the duration represented by the color bar in the timeline.
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Sequence-level effects added to populated tracks are limited and linked to the range of the track item to which they are applied. Linked soft effects are moved and edited along with their parent track item. If you add a soft effect to an empty track, this behavior doesn't apply. You can add sequence-level soft effects by right-clicking track items and selecting Effects or by clicking the Effects icon in the timeline Editing Tools and selecting the required effect. Clip-level soft effects can only be applied when a clip is opened as a timeline using the right-click Open In > Timeline View option. The following soft effects are currently available: • Transform • Mirror • Crop • TimeWarp • Grade • LUT (OCIOFileTransform) • CDL (OCIOCDLTransform) • ColourSpace (OCIOColourSpace) • Text



Create Comp Create Comp adds containers to the timeline that ‘wrap up’ Nuke .nk scripts, allowing them to be played back, versioned, and edited in the timeline as you would normally do with image clip media. A Comp container points to an .nk file on disk and can be seen as clips in the bin or as track items in a sequence. You can Create Comp using a pre-defined export preset or by using Create Comp Special, which allows you to set the export properties on a shot-by-shot basis. Both options are available by right-clicking track items and selecting Effects or by clicking the Effects icon in the timeline Editing Tools and selecting the required option. Double-click a comp on the timeline, or right-click the comp and select Open In > Node Graph, to open up the associated script in the Node Graph.



Annotations Annotations allow you to draw paint strokes and add text to your footage directly in the Timeline Viewer, enabling you to add artistic direction or comp notes to your shots, and communicate your ideas visually to others. You can enable annotations in the Viewer by clicking the annotations button in the Timeline Viewer toolbar (paint brush). This button also toggles the visibility of annotations. From here you draw paint strokes or add text notes using the left-hand toolbar. The color and stroke width of annotations can be modified, as well as the text’s font. Annotations can be added to track items at sequence or clip level, or on a per-frame basis, using the ‘+’ button on the toolbar. They are saved into the project and can be exported into Nuke scripts. These can be passed on to artists and viewed in Nuke by connecting the Annotations Precomp to the Viewer.
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AAF Import and Conform You can now import and conform .aaf files in a similar way to .edl and .xml files. This initial implementation may fail to conform certain file formats, but these are scheduled to be addressed in a future release.



Frame Server Nuke Studio's new Frame Server is capable of rendering frames internally on multiple processes or on external machines to accelerate the rendering even further by sharing work across a network of machines. Nuke Studio's Frame Server can be set up on an external machine (or a number of machines) to render from your Nuke Studio session. To do this, you need to run the runframeserver.py script on the external machines, found inside the Python site-packages, with specific command line arguments. NOTE: The Frame Server requires a Nuke Studio license (nukestudio_i) on the main workstation, but only a Nuke render license (nuke_r) on the slave machines. If you want to use an interactive license (nuke_i) on the slave machines, add the --useInteractiveLicense argument to the runframeserver.py command.



Background Renders Panel A new Background Renders panel has been added, showing the progress of every Comp’s background render and includes a Logs tab reporting status for each render. The Export Queue also displays error logging.



Viewer Re-design Nuke Studio has two distinct Viewer types: Timeline and Compositing. The overall UI has been re-designed to make them the same in all major aspects, with some differences specific to their purpose. For example, the Timeline Viewer doesn't have any 3D controls or bounding box. Nuke's frame slider has also been improved for ease of use.



Workspace Overhaul Nuke Studio features several new workspaces designed to help navigate around the various modes and workflows invloved in the application. The default workspace, Finishing, contains a mix of the timeline and compositing environment panels, letting you quickly switch between the two. Tabs in separate panels come to the fore if one of the other tabs in their linked group are brought to the front.
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OCIO • BUG ID 38019/43995/44008/44484 - OCIO: You can now set a project specific OCIO config file in the Timeline environment, independent of the Preferences, by navigating to Project > Edit Settings > Color Management tab. Any actions from the Timeline environment that use OCIO settings, such as Create Comp, use this setting. New projects and Nuke scripts always pick up their OCIO settings from the Preferences > Project Defaults > Color Management settings. • BUG ID 45414 - OCIO: Nuke now sets sensible default color transforms automatically when you specify a custom OCIO config file.



Feature Enhancements • ParticleBounce now includes a geometry input, allowing you to specify Nuke-native or imported geometry as the bounce surface. • BUG ID 3448/8412 - The Camera, Light, and Axis nodes now have look at and axis inputs. • BUG ID 10128/44281 - mov64Writer: Writing QuickTimes now adds timecode metadata to the resulting container. • BUG ID 13889/37787 - Curve Editor: You can now press Tab to switch between x and y values when manually editing curves. Pressing Esc exits the editing dialog. • BUG ID 18992 - Viewers: The current frame control now accepts simple mathematical functions to navigate through clips, such as +10 to advance 10 frames. • BUG ID 28082/36645/38990 - Nuke now includes Sony SLog2, SLog3, Canon CLog, and Gamma2.4 in the root LUTs and nuke-default OpenColorIO config file. The Viewer LUTs have also been updated to include rec1886 and the Gopro Protune LUT has been added to Nuke's root LUTs and Colorspace node. • BUG ID 33304 - R3D: Nuke now ignores either the X or A frame of HDRx files, depending on selection in the Read node properties (Compositing environment) or Media panel (Timeline environment), so that the timecode is correct. • BUG ID 34333 - Tags: Two new Timeline Viewer hotspots have been added, in addition to the current sequence and frame, allowing you to tag the current track item or the current clip, including versioned clips. • BUG ID 35975 - exrReader: Reading in .exr files with an aspect ratio of 1.0 specified in the header now works as expected, rather than converting the ratio to 0. • BUG ID 37787 - Curve Editor: You can now press Tab to switch between x and y values when manually editing curves. Pressing Esc exits the editing dialog. • BUG ID 38990 - The Gopro Protune LUT has been added to Nuke's root LUTs and Colorspace node. • BUG ID 39148 - Linux only: mov64Reader now reads alpha channels correctly. • BUG ID 40233 - Mac OS X only: Nuke now supports AJA Io 4K SDI broadcast monitor out for Thunderbolt 2 devices with the AJA SDK version 11.2 installed. • BUG ID 41273 - Linux only: Audio tracks can now be combined with video tracks on export using the mov64 encoder.
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• BUG ID 42691 - Improvements have been made to the mov64 decoder/encoder color handling, which now uses 16-bit intermediate formats to reduce banding in 10-bit codecs. Additionally, Nuke now uses Rec601 and Rec709 colorspaces correctly according to resolution. • BUG ID 42803 - The R3D SDK has been updated to 5.0 for the CPU path only. This update adds a new colorspace and gamma setting, DragonColor and RedGamma4, and support for the Red Dragon camera and sensor. • BUG ID 42914 - Read: A new Metadata tab has been added to the Read node's properties panel, allowing you to access metadata from the associated files. • BUG ID 43679 - R3D: GPU debayering has been added to the r3dReader, allowing for fast decodes without a Red Rocket card. NOTE: GPU debayering is no available in the Timeline Viewer. • BUG ID 43923 - BlinkScript: Kernel compilation error messages have been improved to help diagnose issues more easily. • BUG ID 44027/44285 - mov64Reader: Nuke can now read Mpeg-4 and mp4 files through the mov64 reader as well as treating multi-part .m4v as frame sequences. • BUG ID 44267 - Crash Reporter: The feature list has been updated to include Studio-specific features. • BUG ID 44286 - Monitor Out: On AJA Kona 3G and above, 12-bit 4:4:4 3G SDI output is now supported in addition to 8- and 10-bit 4:2:2. • BUG ID 44479 - Viewers: The keyboard shortcut to enable overscan (Alt+O) has been re-purposed to remove out points. • BUG ID 44590 - The toggle Viewer overlay shortcut has changed from O to Q, and the RotoPaint shortcut to return to the current Select tool has changed to Esc. • BUG ID 44894 - Playback Cache: Viewer playback cache bars now show the intersection of the A and B input buffers' cached frames. A frame is only highlighted in green if it's cached in both buffers. • BUG ID 45268 - The RIP framework and Blink API are now versioned in the same way as DDImage. • BUG ID 45505 - UHD_4K has been added to the root formats in the timeline and compositing environments. In addition, the Comp and Timeline root formats have been made more consistent. • BUG ID 45532 - Viewers: New fields have been added to set the frame range on either side of the frame slider. These fields work in the same way as Nuke 8's frame range control to quickly set in an out points. • BUG ID 45589 - Comp Viewer: The Freeze UI button has been removed from the Viewer controls and is now enabled as standard. The new behavior stops updates elsewhere on the interface during RAM cache playback, helping to optimize the playback frame rate. • BUG ID 45703 - The Freeze GUI (snowflake) button has been removed from the Compositing Viewer. Updates to Nuke's GUI are now frozen by default during playback. • BUG ID 45818 - Viewer: The proxy resolution dropdown now displays an asterisk next to the ratio, such as 1:1*, when the resolution was set automatically. • BUG ID 45829 - GPU Acceleration: The FN_NUKE_DISABLE_CUDA environment variable has been renamed FN_ NUKE_DISABLE_GPU_ACCELERATION to reflect the fact that it also affects OpenCL (including Mac Pro AMD cards).
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RELEASE NOTES FOR NUKE 9.0V1 | BUG FIXES



Bug Fixes • BUG ID 7420 - Precomping a script containing a Precomp produced black output, but did not report any errors. • BUG ID 9225 - Curve Editor: The handles click area was too small, causing the value edit box to display instead. • BUG ID 11445 - mov64: H264 encoded files always opened with an incorrect colorspace. • BUG ID 12742 - Windows only: The mov64 reader reported a Bad value for codec : avc1 error when the mov64 prefix was used in a Write node. • BUG ID 16226 - mov64Reader: Files encoded using the H264 codec occasionally displayed the wrong start frame when scrubbing the frame slider and mousing over the Viewer. • BUG ID 21307 - Linux only: Reading in files using the mov64 reader caused Tracker and CamerTracker to track more slowly. • BUG ID 24059 - ScanlineRender: The playback cache bar did not always work as expected when the bg input was not connected. • BUG ID 27784 - mov32/mov64: Command line or Terminal output was too verbose during decode. • BUG ID 31431 - mov64: HD .mov files were read in at the 1920x1088 format, rather than 1920x1080. • BUG ID 32991 - Compositing Viewer: Locked cameras did not retain 3D view zoom or pan moves when switching between 3D and 2D views. • BUG ID 33254 - PlanarTracker: The Select All tool was enabled by default, rather than the Draw tool. • BUG ID 35627 - Rendering long sequences displayed a Too many open files error. • BUG ID 38006 - ColorCorrect was slower to cache in newer version of Nuke than in previous versions. • BUG ID 39135 - Transcoding or exporting timelines with multiple tracks took longer than expected to render. • BUG ID 39338 - DopeSheet: Attempting to undo a Move for a selection of keyframes did not work as expected. • BUG ID 40278 - Compositing Viewer: Adding a new layer reordered the channel list. • BUG ID 40821 - Licensing: Pressing Enter in the lIcensing dialog did not select the Install button. • BUG ID 41032/41915 - Disconnecting the image input at the top of a node tree containing a Denoise node upstream of an OFX node, such as Keylight, caused Nuke to crash. • BUG ID 41200 - Running Nuke in --safe mode still loaded plug-ins from the Nuke plugins directory. • BUG ID 41630 - Nuke Studio would not play back clips when no audio device was selected. • BUG ID 41631 - Scrubbing in the Viewer with an STMap node in a customer script caused Nuke to crash. • BUG ID 41697 - The full name of a folder in the file browser favorite list was not displayed if the name contained spaces. • BUG ID 42018 - Panning or zooming in the Viewer in A/B wipe mode occasionally clipped input buffer A. • BUG ID 42036 - QuickTime: Files encoded using the H264 appl - avc1 codec from Final Cut Pro X were incredibly slow to work with in the Viewer. • BUG ID 42111 - BlinkScript: Recompiling kernels when the called function declares a variable with exactly the same name as a scoped variable in the caller function, returns garbage data.
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• BUG ID 42122 - BlinkScript: Loading a script containing a BlinkScript node that referenced a file, disabled the Load button until you recomplied the kernel. • BUG ID 42506 - Windows only: In workspaces with Scopes panels, activating wipe caused cached playback to slow down in the Viewer. • BUG ID 42550 - mov32/64: Nuke always used the rec601 colorspace regardless of resolution. • BUG ID 42620 - CameraTracker: Tracking still frames occasionally failed when running Nuke from the command line. • BUG ID 42645 - Conforming: Nuke Studio could not interpret Final Cut Pro 7 XMLs that contained files with the tag. • BUG ID 42671 - Starting Nuke in --safe mode did not ignore the Preferences > Behaviors > Startup > startup workspace setting. • BUG ID 42832 - Windows only: When using the timeline Viewer, the Histogram and Vectorscope did not update when scrubbing in the timeline, playing back, or adjusting properties. • BUG ID 42899 - Denoise: Certain scripts containing Denoise and Copy nodes caused image corruption. • BUG ID 42974 - Scan For Versions recognized .tmp files as versions, increasing the scan time. • BUG ID 43359 - Mac OS X only: Expanding a floating Viewer to fullscreen (Cmd+F) left the Viewer tab in front of the fullscreen Viewer. • BUG ID 43402 - It was not possible to manually enter numbers into the Compositing Viewer fps dropdown if the dropdown was set to Auto. • BUG ID 43404 - The Timeline Viewer's fps dropdown did not contain any selectable presets. • BUG ID 43485 - Scopes: Disabling Preferences > Panels > Scopes > Include viewer color transform with a scope present in the workspace caused Nuke to crash. • BUG ID 43696 - Opening a sequence in a spreadsheet (right-click Open In > Spreadsheet View) and then attempting to Match Media caused Nuke Studio to crash. • BUG ID 43768 - The right-click timeline option Build Track > From Export Tag added the same Nuke tag as Create Comp, which was misleading. • BUG ID 43792 - Right-clicking a bin clip and selecting Versions > Scan for Versions changed the frame range of the clip when the scanned directory contained .tmp files. • BUG ID 43813 - Keylight: Adding a Keylight node with no inputs to a script upstream of a LensDistortion node caused Nuke to crash. • BUG ID 43869 - QuickTime: Nuke's movReader failed when using the mov: prefix. • BUG ID 43878 - Disconnecting Denoise from the source clip, in a customer script, caused Nuke to crash. • BUG ID 43895 - Keylight: Adding a Keylight while rendering a customer script caused Nuke to crash. • BUG ID 43979 - The default percentage of total memory for Preferences > Caching > playback cache size was too high, causing performance issues on lower-spec machines. • BUG ID 43985 - Tags: User-created tags added to a track item, track, or sequence using the right-click Tags menu, did not carry any metadata key/value pairs. • BUG ID 44064 - Tags: Adding custom key/value pairs containing .tag caused the tag to disappear.
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• BUG ID 44066 - R3D: The color wheel in the Media panel for .r3d files did not have the same orientation as Nuke's color wheels. Opening .r3d files in the Timeline workspace caused all Nuke's in-panel color wheels to behave in the same way. • BUG ID 44144 - PlanarIop: Using PlanarIop slowed down performance when ScanlineRender contained samples. • BUG ID 44378 - Documentation: The Planar Iop section of the NDK Dev Guide contained several gaps and errors. • BUG ID 44396 - EXR: Reading tiled .exr files was slow and was not improved by adding more threads. • BUG ID 44429 - Windows only: Running the command hiero.core.pluginPath() in the Script editor, returned ..AppData/Roaming/TheFoundry/Hiero. • BUG ID 44578 - MatchGrade: LUTs created from MatchGrade clipped values incorrectly. • BUG ID 44712 - The Output node's appearance was identical to the Input node. • BUG ID 44814 - BlinkScript: An output image could have less than the full amount of channels (4) required for pixel-wise kernels. • BUG ID 45274 - GPU Acceleration: Launching Nuke from the command line using the --gpu argument, disabled the Local GPU control in the properties of accelerated nodes, such as Kronos. • BUG ID 45512 Licensing: An internal licensing environment variable contained an invalid . (period) character. • BUG ID 45593 - Viewers: Resizing or zooming in a Viewer in A/B mode caused displacement of the buffers across the available screen space. • BUG ID 45692 - QuickTime: Audio did not play back from certain QuickTimes with non-integer framerates using the mov64 reader. • BUG ID 45900 - Text: Deleting the second of any two of the same character next to each other, changed the size of the first character. • BUG ID 45904 - Text: Frame expressions on character transforms confused which character to transform. • BUG ID 46072 - Export: During an export, if you pressed Pause, Stop All, or Clear Complete and then pressed Continue, the export remained at 0% and could cause Nuke Studio to crash. • BUG ID 46273 - VectorGenerator: Connecting a Viewer to a node tree containing a VectorGenerator, where the image moved out of the bounding box or changed resolution, caused Nuke to crash.
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Developer Notes Here are the changes relevant to developers. See Help > Documentation from the Nuke menu bar for more information. NOTE: Node Class() names occasionally change between major releases, such as Nuke 7 to Nuke 8. While these changes do not affect legacy scripts, you may not get the results you were expecting if a node class has been modified. The toolbars.py file, used to create Nuke's node toolbar, contains all the current node class names and is located in /plugins/nukescripts/ for reference. As an example, between Nuke 7 and Nuke 8, the Text node Class() changed from Text to Text2. In the toolbars.py file for the two releases, the entries for the Text node appear as follows: m.addCommand("Text", "nuke.createNode(\"Text\")", icon="Text.png") m.addCommand("Text", "nuke.createNode(\"Text2\")", icon="Text.png")



New Features • Nuke Studio's Help > Documentation landing page now includes the Hiero Python Developers Guide containing information on all the new functions available through the Python API. • The Python module psutil is now included in the site-packages by default. Nuke includes Hiero's existing Python modules for conforming, clip management, timeline editing, versioning, round-tripping, export, and so on. • BUG ID 44676 - A new foundry.ui.openFileBrowser() method has been added, allowing you to raise the Nuke file browser to retrieve lists of files and directories. See help(foundry.ui.openFileBrowser) for usage details.



Feature Enhancements • BUG ID 42722 - Linux only: Nuke now calls XInitThreads at startup to avoid certain crashes caused by an assert in X11. • BUG ID 45312 - A new method, BackdropNode::getNodes(), has been added to return a list of nodes contained within a Backdrop node. • BUG ID 45529 - Custom toolbars are now added to the content menu Windows > Custom menu, rather than the Pane menu.



Bug Fixes • BUG ID 44660 - Calling methods on a TimelineEditor object that was not open in the GUI caused the application to crash.
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Nuke 11.1v3 Release Notes 

12.04.2018 - For links to the correct source files, see the Nuke Developers page under ..... audio frame of a QuickTime encoded with AAC compression is muted. ...... BUG ID 186119 - Projects containing .jpg shots with corrupt EXIF data ...










 








Nuke 11.0v1 Release Notes 

24.07.2017 - distortion in an image using automatic Grid Detection or draw curves in the Viewer manually to solve the lens .... BUG ID 273472 - Frame Server: Canceling or pausing a comp render in the Background Renders .... BUG ID 40206 - Adding a cu










 








Nuke 11.1v1 Release Notes 

07.12.2017 - background for updates to the source files, notifying you if they become outdated. ..... BUG ID 40206 - Adding a curve to the Dope Sheet and then deleting it causes Nuke to crash. â€¢ BUG ID 39426 ... BUG ID 273472 - Canceling or pausing










 








Nuke 5.1v4 Release Notes 

03.04.2009 - ent on Mac OS X and Windows), so that when you view them in QuickTime ...... To change convergence, you need a disparity field that maps the ...... All the useful actions can instead be done by using calls on Knob objects.










 








Nuke 11.2v1 Release Notes 

17.07.2018 - NOTE: To ensure you get the best performance from OpenCL GPUs, we recommend updating Mavericks to 10.9.5, or above for full functionality ...










 








Mari 3.2v1 Release Notes 

15.12.2016 - BUG ID 218222 - Mac OS X only: Mari sometimes failed to export channels flattened and merged layers. â€¢ BUG ID 218396 - The colorspace ...










 








Release Notes - UserManual.wiki 

08.05.2015 - Indicates a tip that may help you solve a problem or save time. Provides additional information to emphasize or supplement important points of ...










 








Release Notes 

Dialogannahme Cockpit – neue Funktionen. Beschreibung ... Länder. Alle neuen verfügbaren Länder können in der Kennzeicheneingabe über das gewohnte ...










 








Release Notes 

NEU: Erkennung auÃŸerhalb von 8MAN reaktivierter Konten . ..... Scan-Vergleich: Organisationseinheiten werden zurzeit nicht aufgelÃ¶st. 6526. Der CSV-Report ...










 








Release Notes 

Ãœberwachung von Nutzerkonten: â€žKennwort zurÃ¼ckgesetztâ€œ und â€žKonto gesperrtâ€œ . ..... Scan-Vergleich: Organisationseinheiten werden zurzeit nicht aufgelÃ¶st.










 








Release Notes 

geÃ¤nderten Berechtigungen berÃ¼cksichtigenâ€œ nur aktiviert, wenn ein Konto ...... Scan-Vergleich: Organisationseinheiten werden zurzeit nicht aufgelÃ¶st. 6526.










 








Release Notes 

... fÃ¼r das Erstellen neuer Konten erfolgt in der Scan/Ã„nderungskonfiguration .... Scan-Vergleich: Organisationseinheiten werden zurzeit nicht aufgelÃ¶st. 6526.










 








Release Notes 

Weiterhin braucht der durchführende Account eine der .... vSphere Datenstände werden nicht automatisch gelöscht, wenn man den Datenstand mit der.










 








Release Notes 

In der 8MAN Scan-Vergleich-Ansicht rechts oben: ... enthÃ¤lt alle Berechtigungen einer oder mehreren Konten auf einer oder mehrerer Ressourcen auf Ihrem ...










 








SkillCon 2012 Vol 2 Release Notes German 












 








Notes: 

Le deseamos que disfrute del generador de C02 por gas LP de Titan Controls por muchos aﬁos. SERVICIO CUBIERTO FOR LA GAR










 








news release news release news release - InPrint 

01.05.2015 - Wie der InPrint Messeveranstalter FM Brooks bekannt gibt, vervollstÃ¤ndigt HP mit seiner gerade bestÃ¤tigten Teilnahme die ausstellenden ...










 








preview notes 

Duration: 15 minutes. Almost certainly composed for January 5, 1727, Cantata ... into a ship, and passed over, and came into his own city.' Following a medieval ...










 








news release news release news release - InPrint 

01.05.2015 - renommiertes, weltweit fÃ¼hrendes Unternehmen im Digitaldruck wie er in ... Fusion 3D-Drucktechnologie, aber ebenso auch fÃ¼r die bereits ...










 








game notes 

26 ene. 2019 - Atlas. Cruz Azul. Santos Laguna. Monarcas. Club Tijuana. Pachuca. León ... Club América will face Monterr










 








Meeting Notes 

12 feb. 2019 - Brain Trust Meeting Notes – February 12, 2019. Page 2 of 3. I. Welcome, Introductions. • Holly Mata conve










 








Energy notes 

27 feb. 2002 - The second instance where WMD preserved the regime was more surprising. ... or biological weapons against










 








Product notes 

XUSP02964 Engraving kit (includes the following). XUSP02965 Universal support plate (half size). 1 Engraving head. XUSP02966 Universal support plate (full ...










 








senior notes 

18 jul. 2019 - de Prudential en Estados Unidos en el último siglo se ha distinguido por la fortaleza, estabilidad, exper
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